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مرداد 1384

آشنايي با فرم هاي  InfoPath و نحوه پر كردن آنها:
ساده ترين كاري كه با InfoPath مي توان انجام داد پر كردن يك فرم و Submit كردن آن است.  در اين بخش نحوه انجام اين كار را ياد خواهيم گرفت.

در Infopath فرم ها به دو نوع مي توانند باز شوند: باز شدن براي  طراحي فرم  و باز شدن براي پر كردن يك فرم آماده.

براي ياز كردن يك فرم براي پر كردن آن  در نوار منو File>Fill Out a Form را انتخاب كنيد. با اين كار ديالوگ Fill Out a Form ظاهر خواهد شد. اين همان ديالوگي است كه همواره موقع  وار شدن به InfoPath ظاهر مي شود. اگر فرم مورد نظر شما  در قسمت Recently Used Forms موجود مي باشد مي توانيد روي آن دابل كليك و آن را انتخاب كنيد در غير اينصورت مي توانيد از گزينه Open براي باز كردن فرم مورد نظر خود استفاده كنيد. همچنين براي اين كار مي توانستيد مستقيما از نوار منو File>Open را نيز انتخاب كنيد.

براي پر كردن فرمي مورد نظر خود مي توانيد روي جعبه متنهاي آن كليك كرده و متن مورد نظر خود را وارد كنيد. فرم ها ممكن است داراي ليست هاي باز شونده باشند.كه مي توانيد آنها را باز و مقدار مورد نظر خود را از داخل ليست انتخاب كنيد. 

شكل 1 يك نمونه ساده از يك فرم  InfoPath است. كه براي ارائه گزارش تخمين پروژه به شركت طراحي شده است.در بالاي فرم دو جعبه متن و دو ليست باز شونده وجود دارد. وجود يك ستاره قرمز در داخل اين كنترل ها نشان دهنده اجباري بودن آنهاست. يعني براي Submit شدن فرم اين قسمت ها حتما بايد پر شوند.
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شكل 1

بعد از اين كنترل ها يك جعبه متن با بر چسب   “نام پروژه“وجود دارد و در زير آن جدولي با چهار ستون قرار دارد. در اين قسمت از فرم مدير پروژه نام پروژه و تخمين هاي انجام شده براي هر بخش از پروژه مورد نظر را وارد مي كند. توجه كنيد كه فيلد ”هزينه اين بخش“ اين جدول بطور اتوماتيك با وارد شدن دو فيلد قبلي پر مي شود. فرض كنيد پروژه چند بخش دارد. براي اضافه كردن هر بخش مي توان دكمه آبي كوچكي را كه درست در زير جدول با برچسب Insert Item  وجود دارد را كليك كرد. با اين كار يك سطر به جدول اضافه خواهد شد. همچنين يك دكمه Insert Item ديگر نيز در زير قرار دارد كه مي تواند براي اضافه  كردن پروژه هاي ديگر به كار رود. اگر نشانگر ماوس را به روي بر چسب “نام مدير پروژه“  منتقل كنيد دگمه خاكستري را درست بغل اين برچسب مشاهده خواهيد كرد. با زدن اين دكمه منوي ميانبر باز خواهد شد.كه با استفاده از آن مي توانيد پروژه جديد اضافه و يا پروژه هاي اضافي را حذف Remove كنيد.تقريبا در قسمت پايين فرم يك دكمه گرد زرد با برچسب Click here to insert Note وجود دارد كه با كليك روي آن جغبه متني به فرم اضافي مي شود كه مي توانيد در صورت نياز يادداشتهايي را در مورد مشتري مورد نظر به فرم اضافه كنيد.
بعد از پر كردن فرم بايد فرم را امضا كرد. پر كننده فرم مي تواند تمام يا قسمتي از فرم را امضا كند. در فرم شكل يك در انتهاي فرم يك دكمه با برچسب Click here to sign this section وجود دارد.اين دگمه براي امضاي تمام فرم قرار داده شده است و با فشار آن مي توان فرم را امضا كرد. با فشار اين دگمه ويزارد Digital Signature ظاهر خواهد شد. براي امضا شما بايد قبلا يك Certificate روي سيستم خود نصب كرده باشيد. اين ‍Certificate را بايد از شركت يا سازماني كه اين فرم را به آنجا ارسال مي كنيد دريافت و توسط Internet Explorer نصب كنيد. روي ويزارد Digital Signature ، Certificate مورد نظر را انتخاب و Netx و سپس Finish را بزنيد و در انتهاي جعبه I have verified this contetnt before sign را چك زده و Sign را بزنيد. 

بعد از پر شدن و امضا خوردن فرم بايد آن را Submit كرد. يعني به شركت مورد نظر ارسال كرد. براي اين كار بايد دكمه Submit را از نوار ابزار انتخاب كنيد. ممكن است يك دكمه نيز روي فرم براي اين كار تعبيه شده باشد.
طراحي يك فرم ساده در InfoPath:
در اين بخش مي خواهيم نحوه طراحي يك فرم ساده، تقريبا چيزي شبيه فرم شكل 1 را در InfoPath ياد بگيريم. براي شروع طراحي يك فرم از نوار منو File>Design a form را كليك كنيد. و سپس در تابلويي كه در قسمت راست ظاهر مي شود New Blank Form را كليك كنيد. حال يك فرم خالي داريد و در قسمت سمت راست تابلوي Design Tasks ظاهر شده است. روي اين تابلو Layout را كليك كنيد تا يك قالب مناسب براي فرم خود انتخاب كنيد. براي طراحي فرم شكل 1، Table with Title را انتخاب كنيد. حال يك Layout  به فرم شما اضافه شده است. اكنون با كليك در قسمت بالا شما عنوان فرم را ” گزارش تخمين پروژه هاي  شركت ويتاكو“ وارد كنيد.

براي طراحي قسمت بالايي فرم مي خواهيم از يك جدول با چهار خانه استفاده كنيم. براي اين كار ابتدا روي نيمه پاييني Layout(زير عنوان) كليك كنيد و سپس از نوار منو Table>Insert>Layout table… را انتخاب كنيد. در ديالوگ ظاهر شده تعداد ستون و سطر ها را 2 وارد كنيد.

مكان نما را در اولين خانه قرار دهيد و ” نام مدير پروژه : “ را تايپ كنيد در تابلو سمت راست روي گزينه Controls كليك كرده و و از ليست كنترلهاي استاندارد TextBox را بكشيد و در خانه اول جدول بيندازيد. همين كار را در مورد ” آدرس پست الكترونيكي مدير پروژه : “ انجام دهيد. در خا نه سوم جدول ”مرحله“ را تايپ كنيد و از ليست Control ها يك DropDown List Box به اين خانه اضافه كنيد.
همين كار را در مورد خانه چهارم نيز انجام دهيد. با اين كار فرم شما چيزي شبيه شكل 2 خواهد شد.
شكل 2
در اين مرحله بايد به ليست باز شونده گزينه هاي مورد نظر را اضافه كنيم. براي اين كار روي ليست باز شونده زير برچسب ”مرحله“ دابل كليك كنيد و با زدن دكمه Add گزينه ها را مثل شكل 3 به ليست اضافه كنيد .
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شكل 3

حال مي خواهيم بخش هاي تكرار شونده (Repeating Section)را به فرم اضافه كنيم. بخش هاي تكرار شونده همواره در زير خود يك دكمه كوچك آبي با برچسب Insert Item دارند كه پر كننده فرم با كليك روي آن مي تواند اين بخش را با تمام كنترل هاي آن بطور تكراري به فرم اضافه كند.
 حال مكان نما را زير جدول چهار خانه اي قرار داده و از روي ليست controlها Repeating section را انتخاب كنيد تا به فرم شما اضافه شود.

سپس در داخل اين Section يك برچسب ”نام پروژه:“ و يك جعبه متن اضافه كنيد.

از ليست Control ها Repeating Table را كشيده و در داخل اين بخش بيندازيد. در ديالوگي كه ظاهر مي شود تعداد ستونها را 4 وارد كنيد. سپس در سطر اول جدول عناوين ستون ها را طبق شكل 4 وارد كنيد.

اكنون بايد يك قسمت اختياري در داخل اين بخش در زير جدول تكرار شونده اضافه كنيم. براي اين كار از ليست Control ها Optional Section را به محل گفته شده اضافه مي كنيم.

حال در داخل اين قسمت برچسپ ”توضيح:“ را وارد و سپس از ليست ‍Control ها يك Rich Text Box  به اين قسمت اضافه مي كنيم.

براي بهتر شدن كار روي Optional Section واقع در زير بخش اختياري دابل كليك كرده و در جعبه متن واقع در پايين ديالوگ ظاهر شده ”Click here to insert note“ را تايپ كنيد. حال موقع آن رسيده است كه يك رنگ و لعاب خاصي به فرم خود بدهيم و فرم خود را جذاب تر كنيم. براي اين كار از نوار ابزار Format>Color Schemes را انتخاب و در تابلوي سمت چپ Burgundy را انتخاب كنيد. 

حال مي خواهيم يك پاورقي و يك Page Break به انتهاي صفحه اضافه كنيم.

براي اضافه كردن پاورقي از نوار منو View>Header and Footer را انتخاب و در ديالوگ ظاهر شده دكمه Footer… را كليك كنيد و در ديالوگ ظاهر شده ” شركت فناوري مجازي آذربايجان.“ را تايپ و دو بار OK كنيد. براي اضافه كردن Page Break نيز كافي است مكان نما را در انتهاي صفحه قرار داده و Insert>Page Break را كليك كنيد.
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شكل 4
اضافه كردن پاورقي باعث مي شود متن اضافه شده به پاوذقي هنگام چاپ در پايين صفحه چاپ شود و اضافه كردن Page Break باعث مي شود تا محتواي فرم تا Page Break در يك صفحه چاپ و بقيه فرم كه در زير Page Break قرار دارد در صفحه جديد چاپ شود. براي مشاهده فرم خود در حالت پر كردن مي توانيد از نوار ابزار Preview Form را كليك كنيد. با كليك Close Preview  در همين مكان مي توانيد دوباره به حالت طراحي باز گرديد.
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شكل 5
كنترل ها در InfoPath:

در اين بخش مي خواهيم كمي با كنترل هاي InfoPath و نحوه تنظيم برخي خصوصيات آنها را بررسي كنيم.

كنترل File Attachment :

اين كنترل به كار بر اجازه مي دهد تا فايل را به فرم الحاق كند.

فرم طراحي شده در مرحله بعد را در نظر بگبربد. فرض كنيد مي خواهيم امكان الحاق فايل را در صورت لزوم به پر كننده فرم بدهيم. براي اين كار كنترل File Attachment را از ليست كنترل ها كشيده و به زير جعبه متن "توضيح:" مي اندازيم. مي خواهيم به پر كننده فرم فقط اجازه الحاق فايلهاي متني با پسوند txt يا doc را بدهيم. براي اين كار روي كنترل اضافه شده دابل كليك مي كنيم تا ديالوگ خصوصيات اين كنترل باز شود. سپس گزينه "Allow user to attach only following file types:" را چك مي زنيم و در جعبه متن زير آن "doc;txt" را تايپ مي كنيم.
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شكل 6
براي تست كردن فرم خود Preview Form را از نوار ابزار كليك كنيد. سپس ‍Click here to attach a file را كليك و يك فايل به فرم الحاق كنيد.

كنترل TextBox :

فرم طراحي شده در بخش هاي قبلي را در نظر بگيريد. براي مثال كاربر مي تواند مقدار فيلد هاي هزينه را "aaa" وارد كند. يا ممكن است كاربر عددي منفي را وارد كند. براي محدود كردن كاربر به اين كه فقط اعداد چند رقمي را وارد كند روي جعبه متن زير فيلد "هزينه هر سطر" دابل كليك كنيد تا ديالوگ خصوصيات جعبه متن ظاهر شود.

در قسمت Data Type گزينه Decimal را انتخاب كنيد و سپس دكمه Format را فشار دهيد. در فيلد ظاهر شده گزينه Currency را انتخاب كنيد و سپس در ليست باز شونده پايين آن گزينه "ّFarsiريال" را انتخاب و OK كنيد.
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شكل 7
اين بار روي جعبه متن زير فيلد "بخش" دابل كليك كنيد. در ديالوگ ظاهر شده به تابلوي Display برويد و گزينه Limit text box to را چك كنيد و مقدار مقابل آن را به 10 تغيير دهيد. با اين كار نام هاي وارد شده در ستون بخش نمي توانند بيشتر از 10 كاراكتر باشند.

مقدار فيلد هزينه اين بخش همواره برابر با حاصل ضرب فيلدهاي تعداد كد تخميني (LOC) و هزينه هر سطر مي باشد. بنابر اين نيازي نيست كاربر اين فيلد را وارد كند و ما مي توانيم آن  را به طور اتوماتيك حساب كنيم. براي انجام اين كار روي جعبه متن مربوطه دابل كليك كنيد و دكمه f​​x ​را فشار دهيد تا ديالوگ Insert Formula ظاهر شود.

حال دكمه Insert Field or Group را فشار دهيد و field7 را انتخاب كنيد(توجه كنيد كه اگر ترتيب طراحي فرم را رعايت نكرده باشد ممكن است اين اسامي با اسامي شما متفاوت باشند سعي كنيد نام فيلد مورد نظر را پيدا كنيد). در انتهاي متن موجود در جعبه متن يك * قرار دهيد و دوباره Insert Field or Group را فشار داده و اين بار field 8 را كليك كنيد.

فرمول حاصل بايد چيزي شبيه شكل زير شده باشد.
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شكل 8
حال به تابلوي Display رفته و گزينه Read-Only را چك كنيد. Preview Form را از نوار ابزار انتخاب كنيد تا فرم را آزمايش كنيد.

حال مي خواهيم جعبه فيلد "بخش" را طوري تنظيم كنيم كه كاربر مجبور باشد نام هر بخش را وارد كند. براي اين كار روي جعبه متن زير اين فيلد دابل كليك و در ديالوگ ظاهر شده Cannot be blank را چك بزنيد. با اين كار كاربر بدون وارد كردن يك مقدار در اين جعبه متن نمي تواند فرم را Submit كند.

جعبه متن زير برچسب "   آدرس پست الكترونيكي مدير پروژه :" را در نظر بگيريد. مي دانيم كه كاربر بايد يك آدرس E-mail را بايد در اين جعبه متن وارد كند. ولي اكنون كاربر قادر به وارد كردن هر متني مي باشد. براي محدود كردن كاربر به آدرس E-mail روي اين جعبه دابل كليك كنيد .

و كليد Data Validation را كليك كنيد. سپس Add را كليك كنيد . در ديالوگ ظاهر شده در ليست اول field2 ، كه همان اسم جعبه متن مربوط به E-mail است را انتخاب كنيد. در ليست وسط گزينه "dose no math pattern" را انتخاب و در ليست سوم تنها گزينه موجود را كليك كنيد تا ديالوگ انتخاب pattern ظاهر شود. در اين ديالوگ در ليست بالا ‍Custom pattern  را انتخاب كنيد. از ليست پايين "Any character:." را انتخاب كنيد بار ديگر گزينه "One or more:+" را انتخاب كنيد و سپس در جعبه متن ، جلوي متن موجود "@vitaco.net" را تايپ كنيد. Ok را بزنيد. در جعبه متن مربوط به Screen tip متن "لطفا آدرس E-mail شركت ويتاكو را وارد كنيد" را تايپ كنيد. حال مي توانيد فرم خود را آزمايش كنيد.

توجه كنيد كه اگر آدرس E-mail را درست وارد نكنيد خط چين قرمزي دور جعبه متن مربوطه ظاهر خواهد شد.

كنترل Choice Section :

اين كنترل برا دادن انتخاب هاي بيشتر به كاربر هنگام پر كردن فرم مناسب است. فرض كنيد مدير كاربر بخواهد به جاي نام پروژه شماره پروژه را وارد كند.

بنابر اين در قسمت بالاي فرم برچسب "نام پروژه" و جعبه متن مربوط به آن را پاك كنيد و به جاي آن از ليست كنترل ها كنترل Choice Section را قرار دهيد.

حال برچسب "نام پروژه" و جعبه مربوط به آن را در اين قسمت قرار دهيد.سپس از ليست كنترل ها يك Choice Section  ديگر را كشيده و زير قبلي بيندازيد.در داخل اين Section برچسب "شماره پروژه" را تايپ و يك جعبه متن به زير آن اضافه كنيد.

براي اينكه ببينيد Choice Section  ها چگونه كار مي كنند Preview Form را از نوار ابزار انتخاب كنيد تا نمايش  فرم شما را هنگام پر كردن نمايش دهد. حالا اگر ماوس را روي برچسب "نام پروژه" قرار دهيد دگمه كوچكي در بغل آن ظاهر خواهد شد كه با فشار دادن آن منوي ميانبر ظاهر خواهد شد. در اين منو گزينه Replace with Group13 (اگر ترتيب انجام كارها را رعايت نكرده باشيد ممكن است نام قسمت مورد نظر در فرم شما فرق كند و Group 13 نباشد. براي يافتن نام قسمت مورد نظر در حال طراحي ماوس را روي قسمت مورد نظر قرار دهيد) را فشار دهيد. حال مي توانيد به جاي نام پروژه ، شماره پروژه را وارد كنيد.

فيلتر كردن داده هاي يك جدول:

در اين بخش مي خواهيم يك ليست باز شونده در بالاي جدول تكرار شونده قرار خواهيم داد تا بوسيله آن جدول را فيلتر كنيم. ابتدا يك ليست باز شونده در بالاي اين جدول قرار مي دهيم. سپس رو آن دابل كليك و سه گزينه به آن طبق شكل زير اضافه مي كنيم.
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شكل 9
حل مي خواهيم جدل را طوري تنظيم كنيم كه با انتخاب گزينه "بخش هاي پايين تر از 10 ميليون ريال" بخش هايي كه هزينه آنها زير 10 ميليون ريال برآورد مي شود و كه با انتخاب گزينه "بخش هاي بالا تر از 10 ميليون ريال" بخش هايي كه هزينه آنها بالاي 10 ميليون ريال برآورد مي شود و با انتخاب "همه بخشها" همه بخش ها انتخاب شود. دقت كنيد كه هنگام وارد كردن اين گزينه هاي Value آنها را all ، big و small قرار دهيد. اكنون روي Repeating Table واقع در جدول دابل كليك كنيد و در ديالوگ باز شده  به تابلوي Display رفته و Filter Data را فشار دهيد. در اينجا بايد شرايط را براي فيلتر كردن جدول وارد كنيم.

دگمه Add را فشار دهيد. در ليست اول نام مربوط به فيلد "هزينه اين بخش" را كه اگر ترتيب را رعايت كرده باشيد field9 است را انتخاب كنيد. در ليست وسط is less than و در ليست سوم Type a number…  را انتخاب و مقدار 10000000 را وارد كنيد. سپس دكمه And را فشار دهيد. در ليست اول Select a field or group را زده و سپس field16 كه همان نام ليست باز شونده است را انتخاب كنيد. در ليست وسط is equal to و در ليست سوم مقدار small را تايپ كنيد. اين كار را طبق شكل زير ادامه دهيد:
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شكل 10
بعد از اتمام اين كار سه بار Ok كنيد و Preview Form را از نوار ابزار كليك كنيد و فرم خود را آزمايش كنيد.

اتوماتيك كردن مقدار فيلد ها:

در اين بخش مي خواهيم كاري كنيم مقدار جعبه متن E-mail را با تايپ شدن نام مدير پروژه به طور خودكار پر شود. 

روي جعبه متن مدير پروژه دابل كليك كنيد و در ديالوگ ظاهر شده Rule و سپس Add را فشار دهيد. در جعبه متن موجود مقدار Name را "Set e-mail" بنويسيد و سپس كليد Set Condition را فشار دهيد. در اين ديالوگ مي خواهيم شرطي را قرار دهيم كه اگر شرط برقرار بود Rule اجرا شود.

در ليست اول نام فيلد مربوط به نام مدير پروژه را (field1)انتخاب كنيد. و در ليست دوم گزينه "is not blank" را انتخاب كنيد و ok را بزنيد.

در ديالوگ Rule دگمه Add Action را بزنيد. با اضافه كردن Action به Ruleهنگامي كه شرط Rule برقرار شد اين Action ها اجرا خواهند شد.

در ديالوگ Action از ليست باز شونده بالايي گزينه Set a field's value را انتخاب كنيد. در جعبه متن اول بايد نام فيلد مربوط به E-mail (field2) را وارد كنيم. براي اين كار از دكمه كوچك بغل جعبه متن استفاده كنيد. 

در جعبه متن مربوط به "Value" بايد فرمولي را قرار دهيم تا آدرس E-mailطبق آن محاسبه شود. بنابر اين دگمه كوچك f​​x را فشار دهيد تا فرمول مورد نظر را توليد كنيم.

در ديالوگ توليد فرمول دگمه Insert Function را وارد كنيد. در ديالوگ ظاهر شده در ليست اول text و سپس در ليست دوم concat را انتخاب كنيد. Concat تابعي است كه دو رشته را به هم متصل مي كند. 
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شكل 11
حال در ديالوگ توليد فرم روي اولين عبارت "double click to insert field" كليك كنيد و از طريق دگمه Insert Function… تابع translate را اضافه كنيد. آرگومان هاي اين تابع را به ترتيب . ،  "" و  "_" وارد كنيد. سپس آرگومان دوم تابع قبلي را "@vitaco.net" وارد كنيد و آرگومان سوم را پاك كنيد:
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شكل 12
اكنون مي توانيد همه ديالوگ ها را ok كرده و پيش نمايش فرم خود را امتحان كنيد.

اضافه كردن Scriptها به فرم:

Script ها برنامه هاي كوچكي هستند كه به فرم اضافه مي شوند و هنگام وقوع وقايع خاصي به اجرا در مي آيند.  در اين بخش مي خواهيم كدي را به جعبه متن اضافه كنيم تا مقدار فيلد "تعداد سطر كد تخميني (LOC)" را چك كنيم.

براي اين كار روي اين جعبه متن دابل كليك كنيد و سپس Data Validation را كليك كنيد. از ليست باز شونده گزينه OnValidate را انتخاب كنيد و سپس دكمه  Edit را فشار دهيد. 

در اين لحظه Microsoft Script Editor (MSE) اجرا خواهد شد.
در اين محيط كد زير را پيدا كنيد:

function msoxd_my_ field7::OnValidate(eventObj) 

{ 

    // Write your code here 

}

و آن را با كد زير جايگزين كنيد :

function msoxd_my_ field7::OnValidate(eventObj)

{

    // Get the value of the itemPrice field.

    var price = Number(eventObj.Site.text);

    if (isNaN(price))

    {

        // If the price is not a number, report an error.

        eventObj.ReportError(

            eventObj.Site,                      // Node with the error

            "This value must be a number.",          // Message for the error

            false);                             // Site dependent error

    }

    else if (price < 0)

    {

        // If the price is less than zero, report an error.

        eventObj.ReportError(

            eventObj.Site,                      // Node with the error

            "This value must be greater than zero.", // Message for the error

            false);                             // Site dependent error

    }

}

حال مي توانيد فرم خود را امتحان كنيد. براي اين كار از نوار ابزار Preview Form  را وارد كنيد. حال مقدار فيلد مورد نظر را aaaa بدهيد. ملاحظه مي كنيد كه نوار نقطه چين قرمزي دور جعبه متن مورد نظر ظاهر خواهد شد.

توجه كنيد كه اگر كد وارد شده شما  داراي خطا باشد InfoPath پيش نمايش فرم شما را نشان نخواهد داد. و خطاي مثل شكل زير ظاهر خواهد شد.
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شكل 13
اگر چنين خطايي را دريافت كرديد به Script خود مراجعه كرده و سعي كنيد خطا را رفع نمايي.

كار با View ها :
مي توانيم فرم هاي InfoPath را طوري تنظيم كنيم كه براي افراد گوناگون، به صورت هاي گوناگون به نمايش در آيند. مثلا وقتي يك مدير فرم را باز مي كند فرم براي يك مدير تنظيم شود و وقتي يك كارمند آن را باز كند فرم كارمند نشان داده شود. 

براي اين منظور View ها را به فرم اضافه مي كنيم و سپس چند User Role به فرم اضافه مي كنيم تا با تشخيص User ، View  مورد نظر را نمايش دهد.

براي اضافه كردن View از نوار منو View>Design Tasks… را بزنيد و از تابلوي سمت راست View را بزنيد. روي View 1 دابل كليك كنيد و در جعبه متن View Name نام اين View را Employee وارد كنيد.

سپس در تابلوي سمت راست در طرف پايين Add new View را كليك كنيد و نام view را Manager وارد كنيد.

از طريق تابلوي سمت راست View مربوط به Employee را انتخاب و همه كنترلها را انتخاب و كپي كنيد و آنها را در View ي Manager  قرار دهيد (Paste كنيد). 

سپس از طريق Format>Color Schemes رنگ اين View را عوض كنيد.

حال بايد يك User Role به فرم اضافه كنيم. براي اين كار از منوي Tools گزينه User Roles را كليك كنيد.

در ديالوگ ظاهر شده Add را بزنيد و نام Rule را Employee وارد كنيد.  گزينه Group name را چك بزنيد و در جعبه متن مربوطه Vitavo\Employees را تايپ كنيد. توجه كنيد كه Employees نام گروهي است كه تمام كارمندان شركت در آن گروه قرار دارند. بنابر اين شما نيز بايد چنين گروهي را توسط Active Directory در سيستم خود ايجاد كنيد .و سپس گزينه Set as initiator را در پايين ديالوگ تيك بزنيد.

به همين طريق يك Role براي گروه Managers كه آن را بايد در سيستم خود ايجاد كنيد بوجود بياوريد.

حال بايد فرم را طوري تنظيم كنيم تا با تشخيص Role ها در هنگام باز شدن فرم View مناسب را نمايش دهد. Tools>Form Options را كليك كنيد. سپس در ديالوگ ظاهر شده به تابلوي Open and Save رفته و دكمه Rule را كليك كنيد. سپس Add را بزنيد. 

در ديالوگ ظاهر شده Set Condition را بزنيد و از ليست اول "current user's role"، از ليست دوم "is equal to" و از ليست سوم "ٍEmployee" را انتخاب كنيد. OK كنيد. سپس Add action را بزنيد و از ليست باز شونده بالايي Switch views و ز پاييني Manager را انتخاب كنيد دو بار Ok  كنيد. حال با همين روش يك Rule ديگر براي Manager درست كنيد.
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شكل 14
بعد از اتمام كار براي امتحان فرم خود از نوار منو Form>Preview Form>with user role… را انتخاب كنيد و يكي از View هاي Manager ياEmployee را انتخاب كنيد. ملاحضه خواهيد كرد كه View متناظر با Role انتخاب شده نمايش داده مي شود.

شِماي فرم در Info Path:

از تابلوي سمت راست گزينه Data source را انتخاب كنيد. 

چيزي كه ملاحضه مي كنيد شماي فرم شماي فرم شماست. وقتي يك Section از نوع Repeating ، Optional و يا هر نوع ديگري از Section را به فرم اضافه مي كنيد يك Group به داخل شماي شما اضافه مي شود. اين Group هاي مي توانند تو در تو نيز باشند چون مي تواند در داخل يك Section ، Section ديگري را ايجاد كرد. جعبه متن ها ، ليست هاي معمولي و باز شونده و چند كنترل ديگر filed  هاي شما را تشكيل مي دهند كه بسته به اينكه در كدام Section  قرار داشته باشند در داخل Group مربوطه قرار دارند. براي اضافه كردن، حذف و يا انتقال Group ها و Fieldها مي توانيد رو ي آنها راست كليك و از طريق منوي ميانبر باز شونده عمليات مورد نظر را انجام دهيد.

[image: image14.png]Data source:

i

= [ myFields
(] field*
(] field2*
(] fielda*
(] fieldd*
|
=/l group2
(] fields
| group3
| groups
| group?
(] fieldts
(] field14





شكل 15
براي مديريت بهتر شماي فرم سعي كنيد اسامي مناسبي را براي Group ها و Filed هاي خود انتخاب كنيد. براي اين منظور مي توانيد روي Field مورد نظر يا كنترل متناظر آن روي فرم دابل كليك كرده و نام مورد علاقه را در جعبه متن Name وارد كنيد.

كنترل فرم هاي InfoPath  از طريق Microsoft Visual Studio .net
در اين بخش مي خواهيم نحوه كنترل يك فرم را بوسيله كد هاي نوشته شده در Microsoft Visual C# .net را ياد بگيريم. 

بري اين منظور Microsoft Visual Studio .NET  را اجرا كنيد و يك پروژه جديد از نوع Microsoft Office InfoPath Projects>visual C# projects ايجاد كنيد. نام پروژه را myInfoPathProject بگذاريد . در ديالوگ ظاهر شده گزينه create new form template را انتخاب و Finish را بزنيد.
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شكل 17
ملاحضه خواهيد كرد كه InfoPath اجرا شده و يك فرم جديد آماده طراحي را باز مي كند. يك كنترل Button  به اين فرم جديد اضافه كنيد و روي آن دابل كليك كنيد تا ديالوگ خصوصيات آن نمايش داده شود. در اين ديالوگ Label دكمه را Hello و ID آن را HelloID قرار دهيد و سپس Edit Form Code كليك كنيد. توجه كنيد كه يك event handler (كنترل كننده رويداد)از نوع OnClick به فايل FormCode.cs اضافه مي شود. 

در داخل اين كنترل كننده رويداد ايجاد شده كد زير را تايپ كنيد:

thisXDocument.UI.Alert("Hello world");
و از منوي Debug گزينه start را بزنيد. 

اكنون فرم شما  نمايش داده خواهد شد. دكمه Hello را بزنيد. در اين لحظه كد اضافه شده شما اجرا شده و يك پيغام "Hello World" نشان داده خواهد شد.

يافتن UserName كاربر جاري:

اين بار مي خواهيم كدي را به فرم خود اضافه كنيم كه با باز شدن فرم نام كاربر جاري را تشخيص و در يك جعبه متن در داخل فرم نمايش دهد. براي اين كار فرم درست شده در بخش قبلي را در InfoPath باز كنيد و يك فيلد با نام UserName در قسمت Data Source در تابلوي سمت راست ايجاد و آن را كشيده و به داخل فرم بياندازيد:
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شكل 18
حال از منو Tools>Programming>On Load Event را بزنيد. با اين كار يك كنترل كننده رويداد باز شدن فرم به كد فرم اضافه مي شود. در داخل اين كنترل گر رويداد كد زير را وارد كنيد:

IXMLDOMNode nodeUserName = 

thisXDocument.DOM.selectSingleNode("my:myFields/my:UserName");

if(nodeUserName != null)

{

if(nodeUserName.text == "")

{

nodeUserName.text = System.Environment.UserName;

}




}
حال مي توانيد فرم خود را امتحان كنيد.  از منوي Debug گزينه Start را بزنيد. ملاحضه خواهيد كه نام كاربري شما در جعبه متن موجود در روي فرم نمايش داده مي شود.

ظاهرا همه چيز درست به نظر مي رسد. Visual Studio را ببنديد و به محل پروژه خود برويد. فايل manifest.xsf را پيدا كنيد و روي آن دابل كليك كنيد. اين فايل همان فرم شماست ولي InfoPath آن را باز نخواهد كرد و يك پيغام خطا صادر خواهد كرد. 

براي حل اين مشكل بايد اين فايل را Register  كنيم. ابتدا روي فايل manifest.xsf راست كليك Open with  سپس Notepad  را انتخاب كنيد تا محتويات فايل را مشاهده كنيد. 

publishUrl  را پيدا كنيد و همراه با مقدارش حذف كنيد و فايل را ذخيره كنيد.  يك فايل خالي باز كنيد و كد زير را در آن وارد كنيد:

oApp = WScript.CreateObject("InfoPath.ExternalApplication");
strAbsolutePath = "C:\\Documents and Settings\\MyUser\\My Documents\\Visual Studio Projects\\myInfoPathProject\\manifest.xsf"
oApp.RegisterSolution(strAbsolutePath,"overwrite");
توجه داشته باشيد كه مسير پروژه  شما ممكن است كمي متفاوت باشد. مسير خود را صحيح وارد كنيد و فايل را با نام register.js در پوشه پروژه ذخيره كنيد. و روي آن دابل كليك كنيد تا كد آن اجرا شود. حال مي توانيد manifest.xsf را با موفقيت در InfoPath باز كنيد.
تهيه و تنظيم : مهندس اصغريان

  Asgharian@ViTACo.net    
	

	آشنایی با InfoPath
فصل اول
    
فصل اول
آشنایی با InfoPath:
  InfoPath محيطي است كه قابليت طراحي فرم هاي ساده را بدون كدنويسي براي كاربران فراهم مي كند.

1-1 طراحی فرم در محیط InfoPath 
    فرم های InfoPath  تماما بر مبنای XML  هستند .

 

1-1-1       فلسفه طراحی فرم
  چندين روش براي شروع طراحي فرم وجود دارد. ممكن است يك شماي از قبل تعريف شده باشد (شامل شمايي براي يك وب سرويس) ، و يا فرم در  قبال يك شما طراحي شود . فرمي كه طراحي مي كنيد ممكن است يك نسخه الكترونيكي از يك فرم كاغذي براي قرار گرفتن در يك فرآيند تجاري باشد .

هر زمان كه ممكن باشد ما به شما پيشنهاد مي كنيم كه ابتدا شماي فرم را طراحي كنيد . دليل اصلي اين است كه از يك شما همه چيز مي تواند جريان پيدا كند . ابزار هايي وجود دارند كه مي توانند يك شماي XMLرا دريافت و يك شماي پايگاه داده را تحويل دهند (مانند Altova’s XMLSpy) . Microsoft’s BizTalk Server از يك شما براي ظاهر عمومي ترجمه اسناد XML استفاده مي كند . نهايتا InfoPath  با XML به سادگي كار مي كند و طراحي يك فرم را در قبال شماي XMLآسان مي نمايد . نهايتا Visual  Studio شامل ابزاري (XSD.exe) است كه مي تواند يك مجموعه درختي از كلاسها را به طور كامل و صحيح توليد كند . بنابر اين اگر شما در نقطه آغاز يك شماي XMLداشته باشيد مي توانيد به طور خودكار مهمترين بخش راهكار خود را توليد كنيد . شروع از هر نقطه ديگر به اي معني است كه بايد يك مرحله براي ايجاد XSDاضافه كنيد .

در اينجا يك استثناي قابل توجه وجود دارد و آن اين است كه اگر شما يك فرم را در InfoPath طراحي كنيد ، InfoPath  يك شماي مطابق W3Cرا به همراه فرم توليد مي كند . اگر شما از كنترل هاي گروه بندي ، Repeating Sectionها ، Optional Sectionها و مانند آن استفاده كنيد ، شما مي توانيد خردمندانه يك XSDخوب را به سادگي با طراحي فرم توليد كنيد . بخش جذاب اين ديدگاه اين است كه به نظر مي رسد براي افراد اين بهتر است كه با فرم مواجه شوند تا اينكه با يك تحليلگر . طراحي يك فرم InfoPath  در طول يك بخش طراحي با كاربر شكل مي گيرد و شما ممكن است حتي ايده و قوانين تجاري را بيابيد كه سريع تر به جريان مي افتد .

 

1-1-1       ایجاد یک فرم 
  پنجره طراحي يك فرم را باز مي كنيد . با كليك بر روي Design a Form Templateدر ويزارد استاندارد آغازين يا منوي فايل .
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شكل 1

شما مي توانيد يك قالب فرم را براي اصلاح باز كنيد و يا از قالب هاي اخير ايجاد شده استفاده نماييد . همچنين مي توانيد يك قالب جديد  يا بخشي از آن را طراحي نماييد . گزينه اي مهيا شده است كه مي توانيد انتخاب نماييد كه يك قالب فرم يا يك بخش نمونه (قالب)اي كه مي تواند از طريق مرورگر در Office serverنمايش داده شود را طراحي كنيد .

 

1-1-2       انواع فرمهای InfoPath
خالي (Blank) : اين انتخاب يك پرده كاملا خالي را براي شروع در اختيار شما قرار مي دهد . اين فرم به هيچ منبع داده اي متصل نيست و هيچ طرح بندي و كنترلي ندارد . InfoPath  فقط شمايي را براي شما مهيا مي كند تا بتوانيد كنترل هايي را که مورد نيازتان است را قرار داده و نمايش دهيد .

وب سرويس (Web Service) : با اين انتخاب ويزاردي براي شما نمايش داده مي شود براي وارد كردن آدرس وب سرويسي كه يك WSDLسازگار با SOAP 2.0را مهيا كند . با يك وب سرويس InfoPath   متدهاي موجود را ليست مي كند . هنگامي كه شما يك متد را انتخاب مي كنيد شماي WSDLدر واقع همان شماي فرم است . پارامترهاي ورودي براي انجام Queryمورد استفاده قرار مي گيرند و پارامترهاي خروجي را برمي گرداند ، ساختار آن به شكل فيلدهاي داده نمايش داده مي شود .

پايگاه داده (Database) : اين گزينه به شما اجازه مي دهد كه يك فرم را به يك پايگاه داده SQLو يا Accessمتصل نماييد .

        نكته :InfoPath  از اتصال داده هاي سيتم عامل كه براي ايجاد يك اتصال داده طراحي شده است استفاده مي كند . در نتيجه هنگامي كه ويزارد برای شما نمايش داده مي شود ، اگر درايور ها را براي آنها نصب كرده باشيد ممكن است پايگاه داده هاي ديگر نيز ليست شود (Oracle، Sybaseو...) . در حالي كه InfoPath  به طور طبيعي نمي تواند به پايگاه داده اي به غير از SQLو Accessمتصل شود . اين به اين دليل است كه اكثر برنامهنويسان حرفه اي مايل به ساخت فرم هاي خود از طريق وب سرويس ها هستند كه از اين طريق قادر به اتصال به پايگاه داده هاي دلخواه خودخواهند بود .

اين ويزارد به شما كمك مي كند تا در جريان آن يك data connection(اتصال به داده) ايجاد كنيد و در اين صورت در فرم خود قابليت Query  ايجاد كردن ، دريافت خروجي به صورت فيلد و ايجاد ديدهاي (View) متفاوت را خواهيم داشت . شما مي توانيد با استفاده از اين گزينه ، داده ها را از پايگاه داده دريافت و تغييرات اعمال شده در آن را ثبت نماييد .

XML or Schema: InfoPath  اين امكان را به شما مي دهد كه يك فرم را در قبال يك سند XMLيا شماي موجود طراحي كنيد . اگر شما فرم را بر اساس يك شما طراحي كنيد ، منبع داده فرم منحصر به اين شما (Schema) خواهد بود و واسط كاربر (UI) فرم شما تنها مي تواند از روي اين منبع داده طراحي شود .

از طرف ديگر اگر فرم را بر اساس يك سند XMLطراحي كنيد ، InfoPath  اين امكان را مي دهد كه شماي فرم را بر اساس XMLطراحي كنيد . همچنين علاوه بر آن منبع داده  انحصاري نخواهد بود و طراح مي تواند فيلد هايي را به منبع داده اضافه كند كه مي توان آن را در طراحي فرم نيز به كار برد .

كتابخانه اتصال (Connection Library) : InfoPath به شما اين اجازه را مي دهد كه به كتابخانه هاي اتصال ايجاد شده در WSSمتصل شويد و داده ها را در آن ها ذخيره و بازيابي كنيد و از اين اتصال در فرم هاي ديگر نيز استفاده كنيد .

بخشي از قالب كنترلي (Control Template Part) : گزينه جديدي كه در InfoPath 2007 وجود دارد ، قابليت ايجاد يك قالب كنترلي سفارشي بر اساس كنترل هاي ديگر InfoPath است . اگر در طراحي فرم هاي خود از مجموعه اي از كنترل ها با يك ترتيب خاص زياد استفاده مي كنيد مي توانيد اين مجموعه را به صورت يك قالب ذخيره و دوباره در فرمي ديگر از آن استفاده نماييد .

1-1-1       طرح فرم (Design Layout)
     اين ناحيه وظيفه (شكل زير) ساختار هاي مبنا را براي طراحي فرم در اختيار شما قرار مي دهد . شما مي توانيد از طرح هاي جداول از پيش تعريف شده استفاده كنيد و مجموعه اي از فعاليت هايي كه روي جداول انجام مي گيرد را انجام دهيد .
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شكل 2

نكته :جداول طراحي تنها بر روي ظاهر فرم تاثير ميگذارند و هيچ تاثيري بر روي شماي داده يا داده هاي XMLندارند . InfoPath  از يك الگوي طرح بندي دنباله دار (flow layout) استفاده مي كند ، بنابراين بدون جداول طرح بندي تمامي كنترل ها به دنبال هم نمايش داده مي شوند (شكل زير) . براي مديريت طرح فرم بهتر است از جداول طرح بندي استفاده نماييم .
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شكل 3. يك فرم بدون جداول طرح بندي
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شكل 4. استفاده از جداول طرح بندي براي طراحي يك فرم InfoPath
نكته :در اين قسمت بعضي از نكات استفاده از ابزار هاي InfoPath كه ممكن است در طراحي براي شما گيج كننده باشد را ذكر مي كنيم :

·         ممكن است شما اندازه يك شيء كه در داخل يك سلول جدول قرار دارد را تغيير دهيد . شايد شما در اين تغيير ، اندازه شيء را بزرگتر از سلول قرار دهيد . در اين صورت هنگامي كه شيء را انتخاب مي كنيد لبه هاي آن حتي اگر در بيرون از سلول قرار داده شده باشند به نمايش در خواهند آمد . اين موضوع در مورد جداولي كه بصورت تودرتو قرار دارند نيز صادق است .

·         هنگامي كه شما جداول را تودرتو قرار مي دهيد ، يك فضاي خالي بين انتهاي جدول فرزند و پدر بوجود مي آيد (شكل زير) . اين موضوع هنگام قرار دادن محتواهاي ديگر نير بوجود مي آيد . اين فضاي خالي هنگام انتشار ديده نمي شود .
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شكل 5

1-1-1       کنترل ها
    ناحيه طراحي ديگر ناحيه كنترل هاست (Control pane) (شكل زير) . اين تصوير كه مي بينيد كنترل ها مختص فرم هاي قابل نمايش در مرورگر هستند . كنترل ها به 5 دسته تقسيم مي شوند : Standard، Repeating and Optional،File and Picture، Advancedو  Custom.
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شكل 6. كنترل هاي ناحيه وظيفه

همه كنترل ها در فرم هاي قابل نمايش در مرورگر در دسترس نيستند . كنترل هايي در اين حالت قابل استفاده مي باشند در ادامه آمده است :

 

·         Text box
·         Rich text box
·         Drop-down list box
·         List box
·         Date picker
·         Check box
·         Option button
·         Button
·         Section
·         Optional section
·         Repeating section
·         Repeating table
·         Hyperlink
·         Expression box
1-1-5-1 جعبه متن (Text Box)

از آنجايي كه جعبه متن به عنوان عمومي ترين ابزار مورد استفاده قرار مي گيرد ابتدا به آن مي پردازيم :
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جدول 1

هنگامي كه شما يك نوع داده انتخاب مي كنيد ، جعبه متني بر اساس قالبي كه انتخاب كرده ايد ، ورودي كاربر را محدود مي كند . كاربر مي تواند داده را وارد كند ، اما اگر ورودي با قالب نوع داده مطابق نباشد InfoPath براي كاربر خطا مي گيرد . به اين شكل كه اطراف جعبه متني يك حاشيه قرمز قرار داده و يك خطاي فوري به كاربر نشان مي دهد .
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شكل 7.

1-2 اتصال به داده (Data Connection)

فرم های الکترونیکی در صورتی که هیچ محلی برای ذخیره داده های خود نداشته باشند ، کاملاً بیهوده خواهند بود . خوشبختانه Infopath قابلیت های فراوانی را جهت گردآوری داده هایی که کاربران در فرم ها وارد می کنند داراست . همچنین شما می توانید با جنبه های مختلف دریافت داده از هر جایی به داخل فرم کار کنید .

1-2-1 خلاصه

در Infopathانواع مختلفی از Data connectionوجود دارد . شما می توانید از تمام انواع برای خواندن و نوشتن داده استفاده کنید اما برای طراحی فرم بر اساس این مدل ها تنها از بعضی از این Data onnectionها می توان بهره برد .

[image: image25.png]Connection ¢s: PR
SQLserver X
Web Server X
XSD X
XML X
Data connection library X

Email





جدول 2.  Infopath و Dataconnection
 

شما می توانید یک فرم بر پایه جدول یا Queryهای SQL Server،  وب سرویس، سند  XMLیا مدل XSDایجاد کنید.هنگامی که یک فرم ایجاد شد شما می توانید از اتصالات دیگری جهت دریافت داده برای استفاده در فرم استفاده کنید یا برای ثبت داده های یک فرم مورد استفاده قرار دهید.

1-2-2 جنبه های تعیین اعتبار

با استفاده از Data connection  شما به دنیای تعیین اعتبار وارد می شوید . هنگامی که شما یک فرم که داده ها را به پایگاه داده ارسال می کند یا فرمی که قابل نمایش در مرورگر بوده و اطلاعات را به وب سرویس می فرستد ، را طراحی می کنید ، شما باید از نحوه انجام تعیین اعتبار آگاه باشید .

هنگامی که یک اطلاعات یک کاربر به یک صفحه وب فرستاده می شود ، وب سرویس یا هر نوع سرور دیگری ، اعتبارنامه آن داده ها از کلاینت معتبر به سرور فرستاده می شوند . در آن سرور ، فرآیندی که اعتبارنامه (که در مثال وب سرویس، IISاست) را دریافت می کند می تواند آن را به هر سرویس دیگری بر روی ماشین (مثلاً SQL Server) بفرستد . هر چند که آن سرویس نمی تواند در حالت پیش فرض آن اعتبارنامه را به سرور های دیگر بفرستد . از این مشکل به عنوان مشکل دو طرفه (Double-hop)یاد می کنند . این انتظاری است که کاربر از سرور وب دارد و انتظار دیگر که سرور وب از سرور پایگاه داده دارد .
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شکل 8. مشكل معماري "Double-hop"

چهار روش برای حل این مشکل وجود دارد :

·         اعتبارنامه را در یک Connection string  ادغام کنیم : شما می توانید کلمه کاربری و رمز عبور را در یک Connection stringکدگذاری کنید . این روش خوبی نیست . اگر می خواهید این کار را انجام دهید حساب کاربری با سطح دسترسی محدود ایجاد و از آن استفاده کنید .  

·         پروتکل اعتباری Kerberos: با استفاده از ویندوز سرور 2003 و پروتکل Kerberos، شما می توانید باری هر سرور یا مجموعه ای از سرویس ها روی یک سرور ، جهت ارسال اعتبارنامه های کاربر مجوز صادر کنید . به این روش کاربر از اعتبارنامه در مقابل سرور و سرور در مقابل دیگر سرورهای دیگر جهت اعتبار دادن استفاده می کند .

·         سرویس Single sign-onشیرپوینت : شیرپوینت آفیس سرور قابلیت  SSOرا به شما پیشنهاد می کند که شما می توانید از نقشه اعتبارنامه کاربر بر اساس داده های ذخیره شده فرم سعی می کند تا به آن دسترسی داشته باشید استفاده كنيد .

·         UDCاز یک DCL: مایکروسافت آفیس شیرپوینت سرور همچنین یک نوع جدید از کتابخانه ها به نام Data connectionرا پیشنهاد می کند . شما می توانید فایل های  Data connectionرا در یک کتابخانه اتصال داده ذخیره کنید که آنها می توانند به صورت مرکزی مدیریت شوند .

1-2-3 اتصال به داده

InfoPath از اتصال داده برای فرستادن داده به و یا دریافت آن از فرم استفاده می کند . شما می توانید یک مجموعه از اتصالات برای فرآیندهای متفاوت داشته باشید .

اتصالات داده در کادر محاوره ای زیر (tools » Data Connections)مدیریت می شوند . از این ناحیه شما می توانید یک اتصال داده جدید ایجاد کنید ، اتصال داده های موجود را تصحیح کنید و یا حذف کنید .
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شکل 9.

دکمه Convertدر اینفوپث 2007 امکان جدیدی است که یک اتصال داده موجود را به یک فایل اتصال داده در کتابخانه اتصال داده (DCL)تبدیل می کند . این راه بسیار ساده ای برای فرم هایی که دارای Connection Stringادغام شده هستند و می توان آنها را به یک DCLبا مدیریت مرکزی صادر کرد. هنگامی که روی  Convertکلیک می کنید کادر محاوره ای Convert Data Connectionنمایش داده می شود که در آن باید محل قرار گرفتن فایل داده در شبکه را تعیین کنید . اگر این فایل موجود باشد ، InfoPath  به آن اشاره می کند و اطلاعات اتصال را در آن قرار می دهد . اگر فایل موجود نباشد ، InfoPath  یک فایل در محل تعیین شده  ایجاد و اطلاعات اتصال را درآن کپی می کند .

هنگامی که Addرا کلیک می کنید ، شما با اولین صفحه از Data Connection Wizardمواجه خواهید شد (شکل10) . توجه کنید که شما می توانید یک اتصال برای تنها دریافت داده و یا ثبت داده ایجاد کنید و یا بروی مایکروسافت شیرپوینت اتصالات را جستجو کنید .
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شکل 10.

اگر "submit data" را انتخاب کنید موارد زیر را جهت انتخاب دارید :

·         وب سرویس

·         کتابخانه اتصال داده

·         به عنوان یک متن ایمیل

·         در محیط میزبان (host)
و اگر "Receive data" را انتخاب کنید :

·         سند XML
·         پایگاه داده (SQL Server)
·         وب سرویس

·         کتابخانه هاو یا لیست های شیرپوینت

اگر شما گزينه "Search for connections on a Microsoft Office SharePoint Server" را انتخاب كنيد سپس مي توانيد از ليست سايت ها يك سايت شيرپوينتي مورد نظر خود را انتخاب كنيد . بعد از انتخاب يك سايت ، شما مي توانيد از ليست نمايش گذاشته شده اتصال به داده (data connection) مورد نظر خود را برگزينيد (دقت كنيد كه اتصال به داده در شيرپوينت با InfoPath تفاوتي ندارد فقط مديريت آن در شيرپوينت ساده تر است) .  

1-2-4         SQL SERVER
شما مي توانيد داده ها را از SQL Server 2000,2005 دريافت كنيد و يا در آن ثبت كنيد . علاوه بر آن شما مي توانيد يك جدول يا يك ديد از SQL Serverرا به عنوان ساختار داده برگزينيد . اگرچه نكته مهم اين است كه شما تنها مي توانيد از SQL Serverاستفاده كنيد (نه از Oracle، MySQL، Sybaseو...) . به شما پيشنهاد مي كنيم كه از وب سرويس به جاي اتصال مستقيم به پايگاه داده استفاده كنيد زيرا امنيت بالاتري را براي دسترسي به داده ها و پر كردن آنها فراهم مي كند .

براي طراحي يك فرم بر پايه SQL Server، شما با طراحي يك قالب فرم شروع مي كنيد . كه به شما اين اجازه را مي دهد كه به هر كدام از پايگاه داده هاي SQL Serverو يا Access MDB متصل شويد . در طي ويزارد شما يك پايگاه داده و سپس جدول مورد نظر خود را انتخاب مي كنيد . هنگامي كه شما اتصال را ايجاد كرديد ، InfoPath عملا دو اتصال را ايجاد مي نمايد (يكي براي دريافت داده و يكي براي ثبت آن) .
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شكل 11. ايجاد يك فرم بر پايه يك شماي پايگاه داده

 

پس از طي مراحل ويزارد فرمي به شكل زير خواهيد داشت :
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شكل 12. يك قالب فرم جديد با منطق پرس و جو بر روي پايگاه داده

 

1-3كدنويسي در InfoPath
واسط كاربر InfoPath بسيار قوي طراحي شده است . اين محيط امكاناتي نظير قوانين ، اعتبارسنجي ها ، بخش هاي دايناميك و ديدهايي را جهت ايجاد فرم هاي قوي توسط كاربر محيا مي كند . اگرچه شما نمي توانيد هر كاري را در اين محيط استاندارد انجام دهيد . وقتي كه شما احساس مي كنيد كه ابزار موجود در InfoPath براي كار شما كافي نيستند مي توانيد از طريق كدنويسي (C# يا  VB .NET) نياز خود را برآورده كنيد .

نكته :در حالي كه از زبان  Jscriptپشتيباني مي كند ، اين محيط محدوديت هايي دارد - نه فرم هاي قابل نمايش در مرورگر و نه فرم هاي امن در حال اجرا نمي توانند از Jscriptاستفاده كنند- علاوه بر آن ، مديريت كد به شما گزينه هاي جديدي جهت انتخاب مي دهد ( مانند استفاده از محيط هايي مانند VSTOو  VSTO) .  

در اينجا سه محيط براي نوشتن كد پشت فرم هاي InfoPath وجود دارد : Microsoft Script Editor (MSE)(براي Jscript) ، Visual Studio Tools for Applications (VSTA)، Visual Studio 2005 Tools for Office (VSTO)، نسخه دوم . هر دوي MSE  و  VSTAبه همراه InfoPath 2007 نصب مي شوند ؛ VSTOيك محصول مجزا است كه قالب هايي را نصب مي كند و محيطي مشترك را جهت ساخت قالب ها و يا plug-inهايي براي  Word، Excelو يا InfoPath(توسط كدنويسي) محيا مي كند .

1-3-1 Visual Studio Tools For Application (VSTA)
VSTAيك بستر كد نويسي قوي است كه مايكروسافت به عنوان محيطي براي گسترش كاربردهاي حرفه اي از نرم افزار ها ارائه داده است. VSTAامكان ايجاد ، ساخت و اجراي پروژه هاي add-inكه به فرم هاي شما الحاق مي شوند را داراست .

نكته :VSTAاين قابليت را ندارد كه كاربردهايي را به تنهايي ايجاد كند . اين محيط تنها جهت تصحيح يا ايجاد add-inهاست .

اين بستر شامل محيط طراحي جهت نوشتن كد مرتبط با فرم است . در InfoPath 2003 كاربر براي كدنويسي تنها مي توانست از قالب هاي Visual Studioاستفاده كند . در حالي كه در InfoPath 2007 شما مي توانيد به راحتي با استفاده از VSTAبراي فرم خود كدنويسي كنيد .
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شكل 13. پنجره VSTA
 

سه راه براي رفتن به اين محيط وجود دارد :

·         فشردن Alt+Shift+F12
·         انتخاب  Tools> Programming> Microsoft Visual Studio Tools for Applications
·         كليك راست روي كنترل ، انتخاب Programmingو سپس انتخاب يك رويداد جهت باز شدن در VSTA
 

 

2-3-1- Visual Studio and InfoPath
InfoPath 2003 قابليت مديريت كد و يا محيط مجتمع با Visual Studioرا ندارد . سرويس پك1 اشتراك با .NETرا فراهم مي كند . اما به نحو غير استادانه اي طراحي شده بود كه كد نويسي در محيط Visual Studioاما مديريت فرم در InfoPath موجود در سرويس گيرنده انجام مي شد در حالي كه  VSTO 2005فرم را با محيط طراحي مجتمع مي كند كه طراح فرم مي تواند تجربه يك طراحي در محيطي مجتمع را داشته باشد .

در InfoPath 2007 شما دو گزينه داريد : VSTO 2005 SE (Second Edition)(شكل 14) . نسخه بعدي VSيك نسخه جديد از VSTOرا با پشتيباني طبيعي از Office 2007را داراست .
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شكل 14. يك راه كار InfoPath در VS 2005با VSTO 2005 SE
 

علاوه بر آن هنگام كار كردن با قالب هاي فرم مرتبط با كد نويسي ، شما مي توانيد از ابزار هاي XMLداخل VSجهت كار با شما (schema) و فايل هاي XMLبهره گيريد ، به همان خوبي كه از اضافه كردن پروژه ها و مجموعه هاي ديگر به راه كارها بهره مي گيرد . همچنين شما مي توانيد با استفاده از VSTO، add-inهايي را براي InfoPath ايجاد كنيد ، كه مي تواند در ناحيه وظيفه سند فعال شود .

از طريق VS، شما مي توانيد دسترسي كامل به ابزارهاي InfoPath دسترسي داشته باشيد . در اين حالت منوي ابزار InfoPath با منوي ابزار VSتركيب مي شود (شكل 15) .
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شكل 15. منوي ابزار InfoPath با منوي ابزار VS تركيب مي شود

 

شما همچنين مي توانيد همه نواحي وظيفه اي را مايليد از منوي Viewانتخاب كنيد . (توجه كنيد كه نواحي وظيفه به عنوان ناحيه ابزار VSباز مي شوند (شكل 16)) آيتم هاي منوي Publishزير منوي Buildاست . هنگامي كه شما Buildو سپس Publishرا انتخا ب كنيد ، VSپروژه را مي سازد (و هر خطاي كامپايلري را توليد مي كند) و سپس ويزارد آشناي InfoPath را باز مي كند .
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شكل 16. يك پروژه Infopath درVS یا ناحیه وظیفه ی Infopath
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